
HP Service Manager
For the supported Windows and Unix systems

Software Version: 9.31

Patch 2 Release Notes

Document Release Date: April 2013 (Updated September 30, 2013)

Software Release Date: April 2013



Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an 
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained 
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government 
under vendor's standard commercial license.

Copyright Notice
© Copyright 2013 Hewlett-Packard Development Company, L.P.

Trademark Notices
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This 
product includes software written by Tim Hudson (tjh@cryptsoft.com). Smack software copyright 
© Jive Software, 1998-2004. SVG Viewer, Mozilla JavaScript-C (SpiderMonkey), and Rhino 
software Copyright © 1998-2004 The Mozilla Organization. This product includes software 
developed by the OpenSSL Project for use in the OpenSSL toolkit. (http:// www.openssl.org). 
OpenSSL software copyright 1998-2005 The OpenSSL Project. All rights reserved. This project 
includes software developed by the MX4J project (http://mx4j.sourceforge.net). MX4J software 
copyright © 2001-2004 MX4J Team. All rights reserved. JFreeChart software © 2000-2004, Object 
Refinery Limited. All rights reserved. JDOM software copyright © 2000 Brett McLaughlin, Jason 
Hunter. All rights reserved. LDAP, OpenLDAP, and the Netscape Directory SDK Copyright © 
1995-2004 Sun Microsystems, Inc. Japanese Morphological Analyzer © 2004 Basis Technology 
Corp. The Sentry Spelling-Checker Engine Copyright © 2000 Wintertree Software Inc. Spell 
Checker copyright © 1995-2004 Wintertree Software Inc. CoolMenu software copyright © 2001 
Thomas Brattli. All rights reserved. Coroutine Software for Java owned by Neva Object 
Technology, Inc. and is protected by US and international copyright law. Crystal Reports Pro and 
Crystal RTE software © 2001 Crystal Decisions, Inc., All rights reserved. Eclipse software © 
Copyright 2000, 2004 IBM Corporation and others. All rights reserved. Copyright 2001-2004 Kiran 
Kaja and Robert A. van Engelen, Genivia Inc. All rights reserved. Xtree copyright 2004 Emil A. 
Eklund. This product includes software developed by the Indiana University Extreme! Lab (<http:// 
www.extreme.indiana.edu/>). Portions copyright © Daniel G. Hyans, 1998. cbg.editor Eclipse 
plugin copyright © 2002, Chris Grindstaff. Part of the software embedded in this product is gSOAP 
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software. Portions created by gSOAP are copyright © 2001-2004 Robert A. van Engelen, Genivia 
Inc. All Rights Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved. Distributed 
under the Terms of Use in http:// www.unicode.org/ copyright.html.

Adobe™ is a trademark of Adobe Systems Incorporated.

Java™ is a registered trademark of Oracle and/or its affiliates.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.

For a complete list of open source and third party acknowledgements, visit the HP Software 
Support Online web site and search for the product manual called HP Service Manager Open 
Source and Third Party License Agreements.
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Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.

 l Document Release Date, which changes each time the document is updated.

 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go 
to:

      http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport 
ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support 
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

      http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support 
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a 
valued support customer, you can benefit by using the support web site to:

 l Search for knowledge documents of interest

 l Submit and track support cases and enhancement requests

 l Download software patches

 l Manage support contracts

 l Look up HP support contacts

 l Review information about available services

 l Enter into discussions with other software customers

 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp
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What's New in This Release
This section describes important changes in this release.

Updating the Java Plug-in When Using Firefox 17
As of this release, the SM9.31 Web client supports Firefox 17; however, if you have certain Java 
plugin, JRE versions  installed on your web client, you will need to click the Manage plug-in link to 
update the Java Platform Plugin to a newer version.

If you do not do so, problems might occur. For example, workflow graphics cannot display 
correctly.

Activate your JRE7 plugin if blocked by Firefox

Due to a security enhancement in JRE7, Firefox may deactivate your JRE7 plugin for your safety.  
When this happens, a red plugin icon appears in the address bar, next to your web client URL 
string. For example, when you open the web client with  ?telephonyuser=1 appended to its URL, 
Firefox deactivates the JRE7 plugin; as a result, Service Manager cannot function properly (for 
example, cannot execute a telephony call).  In this case, you need to activate your JRE7 plugin for 
your Service Manager web site as described here:

 1. Click the red plugin icon in the address bar.

A message window opens, as shown below.

 2. Click Activate All Plugins.

 3. Select Always activate plugins for this site.

The red plugin icon now disappears from the address bar.

JDK 7 Support for the KM Solr Search Engine
As JDK 6 has already reached its end of life and the KM Solr Search Engine heavily relies on JDK,  
JDK 7 Update 17 has been certified on the Knowledge Management Solr Search Engine in this 
release.
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Updating to JDK 7 is optional but recommended. For more information, see "Knowledge 
Management Update Installation" on page 80.

Embedded JRE Upgraded (Server and Windows 
Client)

This patch release has upgraded the SM server and Windows client embedded JRE  to JRE1.7.

Server

The server embedded JRE for x86 systems has been upgraded  to version 1.7.0_15.

Since the Service Manager server does not come with an embedded JRE for non-x86 systems 
(Solaris, HP-UX, and AIX), users using these platforms need to install one of the following JRE1.7 
versions and make sure server/RUN/jre is a symbolic link pointing to the JRE1.7.

Platform JRE Version

Solaris JRE1.7 (update 15  or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)

AIX JRE1.7 (SR4 or greater)

Note: After applying the server patch, if you need to roll back, be sure to restore your  old  JRE. 
See "Backout Instructions" on page 65.

Caution: Since JRE1.7 is not supported on Solaris 9, HP recommends upgrading your server 
operating system to Solaris 10. If you still want to stay with Solaris 9, a workaround is 
available. See known issue "QCCR1E99940" on page 63.

Windows Client

The Windows client embedded JRE has been upgraded to version 1.7.0_17.

Server Embedded Tomcat Upgraded
In this release, the SM server embedded Tomcat has been upgraded from 6.0.35 to 6.0.36 to take 
advantage of the security fixes in version 6.0.36.

This upgrade requires additional steps when installing the server patch. For details, see "Server 
Update Installation" on page 72.

Note: After applying the server patch, if you need to roll back, be sure to restore your  old 
embedded Tomcat. See "Backout Instructions" on page 65.
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Multi-Thread Email Sending Solution Updated
The multi-thread email sending solution has been introduced since SM9.30p5, by adding a new 
argument mailThreadCount to the emailout parameter. With this solution, the main email thread 
reads email records from the database and places them in a queue, and a number of mail-sender 
threads (N=mailThreadCount) send the emails from the queue. In addition,  there are N+1 
"EMAILOUT" thread entries displayed in System Status, and the corresponding logged-in users are 
counted as N+1.

This solution has been updated in the SM9.31p2 release so that only the main email thread displays 
in System Status and the logged-in users are counted as 1. The reason for this update is that the 
mail-sender threads are internal and therefore should not be displayed or counted.

Ability to Change the Order of Rule Sets
This patch release updates the Workflow Editor in Process Designer to  enable you to change the 
order of rule sets that are applied to a workflow phase or transition. 

To change the order of rule sets:

 1. Navigate to Tailoring > Process Designer > Workflows.

 2. Open an existing workflow.

 3. Select a phase or a transition in the workflow.

 4. Go to the Rule Sets or Actions tab (for a phase) or the Rule Sets section (for a transition), and  
if needed add rule sets to the list.

 5. Select a rule set from the list, and click the Up or Down arrow button to move it up or down.

New Text Strings to Be Localized
The SM9.32p2 release has introduced a number of new text strings, which customers can easily 
localize using the native2ascii tool. 

Naming Convention of Localized Files
Localized versions of resource files use the following naming convention: <basename>_<language_
code>.properties or <basename>_<language_code>_<country_code>.properties. 

Note: The file names are case-sensitive.

The following are two examples.
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Example File Description 

cpe_rcp_en.properties “cpe_rcp” is the base name, and “en” is the language code.

cwc_labels_zh_
CN.properties

“cwc_labels” is the base name, “zh” is the language code, and “CN” 
is the country code.

For a list of language codes (and country codes if any) used in the file names of localized resource 
files, see the following table.

Language Code Country Code Description

  Default

en  English

ar  Arabic

cs  Czech

de  German (Standard)

es  Spanish (Spain)

fr  French (Standard)

hu  Hungarian

it  Italian (Standard)

ja  Japanese

ko  Korean

zh CN Chinese (PRC)

nl  Dutch (Standard)

pt BR Portuguese (Brazil)

ru  Russia

Service Manger uses UTF-8 as the default encoding when interpreting the resources. It requires all 
resources files in native UTF-8 encoding be converted to files containing Latin-1 and/or Unicode-
encoded characters, using the native2ascii tool.

New Text Strings to Be Localized
The following table lists the removed or added text strings in the Web tier and Windows client of this 
release, as well as their corresponding properties files.
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Removed or Added Text Strings Description

<webtier-9.31.war>/WEB-INF/classes/workflowBundle.properties

Added:

 l UP=Up 

 l UP_ITEM=Up Item 

 l DOWN=Down 

 l DOWN_ITEM=Down Item

 l PHASE_ORDER=Phase Order

New strings were added for the 
Workflow Editor in Process Designer.

<webtier-9.31.war>/WEB-INF/classes/conditionEditorBundle.properties

Added:

 l NULL=Blank/NULL

 l NULL_VALUE=NULL

 l STARTS_WITH=Starts With

 l IS_IN=Is In

 l SELECT_A_BOOLEAN=Select TRUE/FALSE..

New strings were added for the 
Condition Editor in Process Designer.

<webtier-9.31.war>/WEB-INF/classes/chMBundle.properties

Removed: 

 l TITLE=Task Editor 

Added: 

 l TITLE=Task Planner

 l MANDATORY=Mark as required\/Set properties 
as read-only in change

 l TASK_CONDITION=Task Condition

 l END_PHASE_INVALID=The End Phase must occur 
after the Start Phase

New strings  were added for the Task 
Planner (labeled as Task Editor before 
SM9.31p2) for the Change 
Management module.

<webtier-9.31.war>/WEB-INF/classes/com/hp/ov/sm/client/webtier/xslstrings.properties
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Removed or Added Text Strings Description

Removed:

 l idsMenuImage=Expand and Collapse Menu  

Added:

 l idsMenuImage=Menu

 l idsMenuImageExpand=Expand Menu

 l idsMenuImageCollapse=Collapse Menu

New strings were added for 508 
compliance.

<webtier-9.31.war>/WEB-INF/lib/cwc-9.31.2004.jar/com/hp/ov/cwc/web/cwc_
labels.properties

Removed:

 l Framework.CollapseNav=Collapse/Expand 
Navigator 

Added:

 l Framework.CollapseNav=Collapse Navigator  

 l Framework.ExpandNav=Expand Navigator

 l Framework.CommandLineField=Command Line

 l Framework.CommandLineBtn=Execute

 l cwc.skipLink=Skip to main content

New strings were added for 508 
compliance.

<Service_Manager_Root/Client/plugins/com.hp.ov.sm.client.eclipse.rcp_
9.31.2004/rcp.jar>/com/hp/ov/sm/client/eclipse/rcp/cpe_rcp.properties

Added:

 l HelpError=Help Error 

 l HelpDocumentationNotInstalled=Documentatio
n is not installed.

New strings were added for the 
message window that opens when 
users click the Help Contents option 
in the Windows client.

Note: These new strings are required 
due to an RCP change made in this 
release.

<Service_Manager_Root/Client/plugins/com.hp.ov.sm.client.eclipse.user_
9.31.2004/user.jar>/com/hp/ov/sm/client/eclipse/user/editors/format/cpee_
format.properties
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Removed or Added Text Strings Description

Added:

 l Props.LockRenderingStyle=Lock rendering 
style

New string added for the Lock 
rendering style property of the 
Notebook control in Forms Designer.

How to Localize New Text Strings
Step 1. Set up the Java development environment on Windows.

 1. Download and install Java Standard Edition 6 or later.

 2. Set the JAVA_HOME variable and add <JAVA_HOME>/bin to the system path.

 3. Open the system command prompt, and run the following command to check if Java has been 
correctly configured:

java  -version

Note: If your Java development environment is ready, this command will print your Java 
version information.

Step 2. Convert the text in a specific language to Unicode.

As an example, the following provides the localization steps for Japanese. The steps for other 
languages are similar.

 1. Translate the added resource text to the target languages, and put the translated text in a text 
file for each language: <basename>_<language>.txt.

 2. Merge your translated recourse text for all properties files into one file, so that you can convert 
all of the text in one go. For instance, for Japanese, put the translated text in sm931p2_RES_
ja.txt.

Note: Make sure its file encoding is UTF-8 (You can copy an existing file in Service 
Manger and then edit it).

The following is an example of translated text, which is provided for demonstration purposes 
only.

# From chMBundle.properties

TITLE=タスクプランナー

MANDATORY=必要に応じてマーク\ /読み取り専用の変更のようにプロパティを設定します。

TASK_CONDITION=タスクの状態
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END_PHASE_INVALID=エンドフェイズでは、スタートフェーズの後に発生する必要があります

#From cwc_labels.properties 

Framework.CollapseNav=崩壊·ナビゲータ

Framework.ExpandNav=ナビゲータを展開

Framework.CommandLineField=コマンドライン

Framework.CommandLineBtn=実行する

cwc.skipLink=スキップしてメインページに進む

 3. Copy sm931p2_RES_ja.txt to a local folder. For example: C:\sm931p2.

 4. Open the system command prompt, and change current directory to the local folder you 
selected in the previous step (for example:C:\sm931p2).

 5. Run the following native2ascii command to convert the text.

native2ascii -encoding utf-8 sm931p2_RES_ja.txt  sm931p2_RES_ja.properties

The converted text should look like the following (the following text is provided for 
demonstration purposes only).

#From cwc_labels.properties

Framework.CollapseNav=\u5d29\u58ca\u00b7\u30ca\u30d3\u30b2\u30fc\u30bf

Framework.ExpandNav=\u30ca\u30d3\u30b2\u30fc\u30bf\u3092\u5c55\u958b

Framework.CommandLineField=\u30b3\u30de\u30f3\u30c9\u30e9\u30a4\u30f3

Framework.CommandLineBtn=\u5b9f\u884c\u3059\u308b

cwc.skipLink=\u30b9\u30ad\u30c3\u30d7\u3057\u3066\u30e1\u30a4\u30f3\u30da\

u30fc\u30b8\u306b\u9032\u3080

Tip: For more information on the usage of the native2ascii tool, see 
http://docs.oracle.com/javase/1.4.2/docs/tooldocs/windows/native2ascii.html . 

Step 3. Append the localized new strings to the localized version of the resource files.

 1. In the sm931p2_RES_ja.properties file, copy the lines from cwc_labels.properties to 
<webtier-9.31>/WEB-INF/classes/com/hp/ov/cwc/web/cwc_labels_ja.properties.

 2. In the sm931p2_RES_ja.properties file, copy the lines from each of the remaining properties 
files and append them to the Japanese version of the files.

Now, the localization process for Japanese is complete.

 3. Restart your web application server and Windows client.
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New Parameters and RAD Functions
This release introduces the following new parameters and RAD function.

 l "Startup parameter: KMSearchEngineTimeout" below

 l "Startup parameter: onewayssl4ws" below

 l "Parameter: acceptsharedcert" on the next page

 l "Startup parameter: maxloginspercluster" on page 19

 l "RAD function: datecmp" on page 20

Startup parameter: KMSearchEngineTimeout
Parameter

KMSearchEngineTimeout

Description
This parameter defines a timeout value in seconds for all Knowledge Management search 
server hosts (including indexing hosts, search hosts, and load balancer hosts). The default is 20 
seconds, and the minimum is 10 seconds.

Note: This parameter is used to prevent overloaded KM search servers from causing 
Service Manager to hang.

See also "QCCR1E80231" on page 30.

Valid if set from
Server's OS command prompt
Initialization file (sm.ini)

Requires restart of  Service Manager server?
Yes

Default value
20 (seconds)

Possible values
No less than 10 seconds (if you specify a value less than 10, 10 is used.)

Example usage
Command line: sm -httpPort:13080 -KMSearchEngineTimeout:25
Initialization file: KMSearchEngineTimeout:25

Startup parameter: onewayssl4ws
Parameter

onewayssl4ws
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Description
This parameter provides the option to use either one-way/anonymous SSL or the more stringent 
two-way/mutual SSL for web services clients in a trusted sign-on (TSO) configuration. When  
enabled, this parameter allows web services clients to access SM SOAP interfaces without a 
certificate. 
 
This parameter is only used for web service integrations, and therefore does not affect the 
TSO behavior of the SM Windows and web clients. If you can vouchsafe your internal security 
policies that govern your Web Services clients integrated with the SM server, this parameter 
enables you to deploy SSO/TSO without the need to specify the stringent ssl_
reqClientAuth:2. You can start specific servlets with parameters onewayssl4ws, ssl_
requireClientAuth:0 and debugnode for a web services integration. 
 
By default, this parameter is disabled. 

Valid if set from
Server's OS command prompt
Initialization file (sm.ini)

Requires restart of Service Manager server?
Yes

Default value
0

Possible values
0: Use two-way/mutual SSL for web services clients
1: Use one-way/anonymous SSL for web services clients

Parameter: acceptsharedcert
Startup parameters change the behavior of the Service Manager server. You can always set a 
startup parameter from the server's OS command prompt.

Parameter
acceptsharedcert

Description

Note: This parameter has been introduced since SM9.30p4, as a hidden parameter; 
however, starting with SM9.31p2, it is no longer hidden.

This parameter defines how the Service Manager server handles signed SSL certificates from 
incoming client requests in a Trusted Sign-On configuration. 

When set to 0 (default)

When set to 0 (default), the Service Manager server validates the signed SSL client certificates 
using standard best practices. The validation procedure is described in the "Secure Sockets 
Layer (SSL) encryption and server certificates" topic in the online help.

Tip: Using the default value of 0 is the recommended and most secure mode of operation. 
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HP recommends you run the Service Manager server with the default value of this 
parameter (acceptsharedcert:0). 

Before attempting to modify the default behavior, consider the following alternative 
workarounds:

 l Do not use the Service Manager Windows client. Instead, use only the Service Manager 
Web Tier as it does not incur the additional maintenance overhead or complexity associated 
with managing numerous signed client SSL certificates.

 l If the Service Manager Windows client must be used in your environment, consider limiting 
the distribution of this client to a small number of users. This minimizes the additional 
overhead costs associated with managing numerous Service Manager Windows clients and 
their unique signed client SSL certificates.

 l Use as many Service Manager Windows clients as needed but disable Trusted Sign-On 
functionality for these users. This eliminates the requirement to generate unique signed client 
SSL certificates.

When set to 1

When the parameter is enabled (acceptsharedcert:1), the Service Manager server allows 
Trusted Sign-On connections using a so-called "shared certificate." The Service Manager 
server validates the shared certificate using only the following two checks:

 l Whether the certificate is issued by a trusted certificate authority.

 l Whether the Common Name attribute of the certificate is in the Service Manager Server's 
trusted clients keystore.

HP provides this parameter primarily for use in customer environments where the following are 
true:

 l There is a requirement to allow access to Service Manager through Trusted Sign-On for a 
large number of Service Manager Windows clients.

 l Creating and maintaining the required signed SSL client certificates adds too much 
maintenance overhead and complexity to IT operations.

By using acceptsharedcert:1, only one client SSL certificate (the "shared certificate") needs 
to be created and maintained. This significantly minimizes the maintenance overhead costs and 
complexity associated with managing signed SSL client certificates. Keep the following in mind:

 l The shared certificate still needs to be copied and distributed to individual Service Manager 
Windows clients before Trusted Sign-On access can be successfully used.

 l By using acceptsharedcert:1, you will have minimized your maintenance overhead and 
complexity of your IT operations at the cost of reduced security in Service Manager. This is 
due to the two simple "shared certificate" validation checks performed by the Service 
Manager server (which were previously described) when running with acceptsharedcert:1. 
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Running the Service Manager server with the recommended default value for 
acceptsharedcert provides the most secure method for enabling Trusted Sign-On features 
because the Service Manager server performs additional validation checks against the client 
SSL certificate. It is also possible, though unlikely, that if a malicious user obtains the 
"shared certificate" the user may be able to gain unauthorized access to Service Manager (if 
the user can then also defeat the NTLM-based implementation of Trusted Sign-On on the 
Service Manager Windows client).

Valid if set from
Server's OS command prompt
Initialization file (sm.ini)

Requires restart of Service Manager server?
Yes

Default value
0

Possible values
0 (Disabled)
1 (Enabled)

Example usage
Command line: sm -httpPort:13080 -acceptsharedcert:1
Initialization file: acceptsharedcert:1

Startup parameter: maxloginspercluster
Startup parameters change the behavior of the Service Manager server. You can always set a 
startup parameter from the server's OS command prompt.

Parameter
maxloginspercluster

Description
In a horizontal scaling implementation, Max Logins for operators is enforced at the cluster level. 
This parameter allows administrators to turn off this feature. By default, this parameter is set to 
1, which means Max Logins for operators is enforced by counting each operator's logins on all 
cluster hosts; when this parameter is set to 0, only logins on the local host are counted.

Valid if set from
Server's OS command prompt
Initialization file (sm.ini)

Requires restart of  Service Manager server?
Yes

Default value
1

Possible values
0 ((Disable Max Logins at the cluster level)
1 (Enable Max Logins at the cluster level)

Example usage
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Command line: sm -httpPort:13080 -maxloginspercluster:0
Initialization file: maxloginspercluster:0

RAD function: datecmp
A RAD function that translates date/time fields to the correct SQL statement dialect. You can use 
this function  in expert search of incidents, as well as in  JavaScript programming.

See also "QCCR1E52991" on page 25.

Function
datecmp

Format
datecmp("DateTimeField1","LogicOperator","DateTimeField2","+/-", "TimeInterval")

Parameters
This function uses the following arguments.

Argument Description Example Value (s)

DateTimeField
1

A date time field in a Service Manager 
table. 

close.time

LogicOperator  A logic operator. >, >=, =,  <=,  <

DateTimeField
2

Another date time field in the same 
Service Manager table.

open.time

+/- Arithmetic operator: +or -. +, -

TimeInterval A string that represents the time 
interval to be added to or subtracted 
from the second date time field. 

The format of time interval can be: d, d 
hh:mm:ss, d h:m:s, hh:mm:ss, h:m:s, 
or hh:m:ss (1 digit mixed with 2 digits). 
Days can be omitted, or at most 9 
digits.  Hours, minutes, and seconds 
can be 1 or 2 digits (from 0 to 99), and 
hour:minute:second as a whole can be 
omitted if you enter only days. 

10 02:03:04

(This string represents 10 days, 2 
hours,  3 minutes and 4 seconds.)

Notes:

 l All arguments must be enclosed in a pair of double quotes; otherwise the query parsing will 
fail.

 l This function supports "AND"/"OR"/"NOT" to concatenate multiple datecmp() calls in one 
query. 
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The following are two examples:

datecmp("close.time", "<", "open.time","+", "1") or datecmp("close.time",">=", 
"open.time","+", "5:0:0") 

problem.status="Closed"  and (not datecmp("close.time",">", "open.time", "+","31 
04:02:30"))

 l You can combine the result of this function  with other query conditions to construct a 
complete query. For example, you can execute one of the following queries when performing 
an expert search of incidents: 
 n  problem.status="Closed"  and datecmp("close.time","<","open.time","+","04:02:30") and 

datecmp("close.time",">=","open.time","+","02:02:30" )

 n  problem.status="Closed"  and datecmp("open.time",">","close.time", "-", "04:02:30" ) and 
datecmp("close.time",">=","open.time","+","02:02:30" )

 n  problem.status="Closed"  and datecmp("close.time",">", "open.time", "+","31 04:02:30")

Note: The first two queries should return the same results, which are  incidents whose closed 
time is between 2 hours and 4 hours from their open time; the third query should return 
incidents that were closed  more than 31 days after their open time.

.  

Example
An example of a JavaScript program that uses this function is as follows:

var f = new SCFile('probsummary', SCFILE_READONLY);

var query = 'problem.status="Closed" and datecmp("close.time", "<", "open.time",
"+", "04:02:30") and datecmp("close.time",">=", "open.time","+", "02:02:30")';

if (RC_SUCCESS == f.doSelect(query))

{

do

{

print(f);

}

while (RC_SUCCESS == f.getNext());

};
       

Certifications
This release includes the following support matrix changes .

Added Support
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 l Firefox 17 (web client and SRC)

 l JRE 7 Update 17 (web client and SRC)

 l JDK 7 Update 17 (KM Solr Search Engine)

 l Tomcat 6.0.36 (KM Solr Search Engine)

 l VMWare vSphere 5.1

 n VMWare ESXi 5.1             (Note:  VMHA is supported; however a client reconnection is required after 
fail-over.)

Discontinued Support

 l Firefox 10, 15 (web client and SRC)
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Enhancements
This release includes the following enhancements.

CR Module Problem Solution

QCCR1E83966 Web 
Tier

As JRE 6 is apporaching its end of life, 
support for JRE 7 on the web client is required 
for all supported versions of Service Manager.

JRE 7 on the Web client is now supported for  
Service Manager 9.31p2  or later.

QCCR1E88963 Web 
Tier

Firefox 17 is not supported for the web tier. Firefox 17 is now supported for the web tier.  

QCCR1E92001 Server Service Manager does not support VMHA 
mode on VMware ESXi 5.1.

Service Manager now supports VMHA mode on 
VMware ESXi 5.1.
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Fixed Defects
This release fixes the following defects.

Server
CR Problem Solution

QCCR1E30967 Attachments that are added via Web services do not 
honor the Max Attachment Size settings in the 
Company or Operator records. 

Attachments that are added via Web services now honor the 
Max Attachment Size settings in the Company or Operator 
records. 

QCCR1E8986 Using a type of TIMESTAMP in a dbdict SQL mapping 
on an Oracle database causes soap faults and a signal 
11 error when saving data into the column. Service 
Manager will not automatically choose this data type, 
but users are able to manually map a database field to a 
SQL type of TIMESTAMP. 

SQL type of TIMESTAMP in dbdict on Oracle no longer 
causes a signal 11 when saving data into the column.
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CR Problem Solution

QCCR1E52991 In a default Service Manager version 7.11 system that 
uses an Oracle database, queries that include date and 
time calculations fail because of SQL syntax errors. 
This prevents the creation of a view that shows all the 
interactions that were closed within 24 hours of being 
opened.

This issue occurs because the date/time fields arithmetic 
calculation concerned query results are incorrect in SM. This 
is true regardless of the database type. This is due to the lack 
of a generic representation of time interval, and the different 
ways to calculate it in those DB server types.

Added a new RAD function datecmp
("DateTimeField1","LogicOperator","DateTimeField2","+/-", 
"TimeInterval") that translates date/time fields to the correct 
SQL statement dialect.   The function can be used in expert 
incidents searching, as well as in JavaScript programming.

For more information, see "RAD function: datecmp" on page 
20.

QCCR1E57668 After reaching Maximum Sessions in a Horizontally 
Scaled system, the following message is printed in the 
sm.log every 30 seconds until someone logs off:  JRTE 
I Not Accepting Connections: Node: 
HostName:xxxxx PID:xxxx HttpPort:xxxx 
ActiveSessions:4 BlockedOnLowMemory:false 
Quiesced:false ChannelAddress:xxxxx   

Now, this message is printed only when the node is neither a 
debug service nor a loadbalancer node.  Additionally, the time 
interval for reporting the message was increased.

QCCR1E59909 You cannot store fields out of sequence in a structured 
array if the structure-type element is new to the array.  
This issue occurs because of an incorrect JavaScript 
implementation that causes the sequence of filling 
fields into the structured array to fail, if a single field is 
not first in the structure.

The incorrect code that failed to handle a field name with 
array path has been fixed. 
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CR Problem Solution

QCCR1E64043 If a duplicated Interaction record has been modified, the 
"refresh" rtecall retrieves the wrong interaction instead 
of the new interaction when the workflow is executed 
after duplicating an interaction record.   

Scenario:  

 1. The user opens Interaction # 1 and escalates it to 
Incident # 1. 

 2. After returning to a blank Interaction, the user 
clicks Last Interaction and then selects Duplicate 
Interaction. 

 3. The User opens Interaction # 2 and associates it to 
Incident # 1. 

 4. The user attempts to save Interaction # 2 after it is 
updated in the background (Open - Linked) and the 
"refresh" rtecall retrieves Interaction # 1 (instead of 
the updated Interaction # 2). 

The "refresh" rtecall now retrieves the new interaction 
correctly.

QCCR1E64366  If a QBE includes Display List and Value List values 
that are Global Lists, you cannot use that field as a 
value to "Chart By" in the Web client.    

The "aggregatable" attribute in the response of "getForm" 
XML specifies whether a field can be put in "chart by" menu 
or not. In this case, the RAD variables affected the value of 
the "aggregatable" attribute even after the attribute was set.  
This behavior has now been corrected.  
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CR Problem Solution

QCCR1E64357 Details of audit records for a configuration item (CI) do 
not display properly. Specifically, the following 
problems occur:  

 l The audit history in the device.audit.vj subform   is 
not shown correctly. 

 l Fields such as operator or the child field of an array 
structure like old.scalar are treated in the same way 
as columns of a table in the form.

 l An audit record may have only one operator, but may 
have several old.scalar values.  However, the form 
would show only the first old.scalar which value is 
incorrect. After applying Patch 15, even the first 
old.scalar value is not shown. 

This subform can be revised to show only ordinary fields of 
an audit record and can have a link to jump to a detail form to 
show an array structure of that audit record.  If users do need 
the audit history to show data in array structure in old.scalar, 
try to implement it by tailoring. To do this, follow these steps:  

 1. Modify the input of the columns of the device.audit.vj 
subform to set the input value to a variable instead of 
field names. For example, substitute $L.old.scalar for 
column old.scalar.

 2. Prepare the variables in a JavaScript by executing a DB 
query and then call this JS in the display screen or 
format control.  The variables can be shown in the 
subform.

Note: Although the above-described workaround is available, 
be aware that Service Manager already supports such a use 
case. When creating a Subform control, you need to fill in the 
Input field, where you can specify the sm database field or 
variable to associate with this control; however, if the 
database field is a complex type, for example, Array type or 
Structure type, you must fill in the Input field using this 
format: ArrayName,FieldName. In this example, it is 
recorded.changes,old.scalar.

 

 

QCCR1E72398 The Service Manager server does not report memory 
leaks at thread termination when using utalloc memory 
manager.  

By default, the SM server now reports memory leaks at  
thread termination when using utalloc memory manager.
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CR Problem Solution

QCCR1E72809 After closing a ticket (such as an Interaction or Incident) 
and returning to the view, the queue is not synchronized 
correctly. 

Now, when detecting a record deletion, SM updates the 
group information so that the queue synchronizes correctly. 

Note: This works only when a user deletes records. If users 
update or insert records, the view display issue will still exist.
 As a workaround, users can click the "Refresh" button to 
solve the view display issue for the latter case.   

QCCR1E72834 An administrator cannot terminate a session that is 
fetching millions of records. This may occur due to a 
poorly created customer view, which can cause 
servlets to consume too much CPU and memory, and 
then terminate servlets.  

Now, administrators can terminate a session that is fetching 
millions of records. 

QCCR1E74528 On ESS, buttons will overlap when display option labels 
are greater than 10-12 characters.

Now, ESS truncates long labels to ensure the buttons do not 
overlap. 

QCCR1E75514 WCF client cannot add an MTOM/XOP attachment 
when calling the SM Web service to create an incident. 

WCF client can add MTOM/XOP attachment when calling 
the SM Web service to create an incident. 

QCCR1E76630 The Status field is shown as "Scheduled" even though 
the "Schedule this index?" checkbox is not checked. 

If "Schedule this index?" checkbox is checked, the status 
will be show as "Scheduled"; if "Schedule this index?" 
checkbox is not checked, the status will be show as 
"Completed".

QCCR1E76724 After deleting the unique key of cm3r, a signal 11 
happened while doing an IR regeneration. 

This issue occurs because the SM server does not 
check to see if there are a unique key and IR key before 
it starts a key regeneration, and thus causes a signal 
11.

The Service Manager server now checks if the number of the 
unique key or IR key is zero. If yes, the server then issues a 
warning message to the client that indicates the IR regen 
cannot be performed without a unique key.

To take advantage of the server fix, you must load 
QCCR1E76724_SM931P2_SM930.unl, available in the 
platform_unloads directory.

HP Service Manager (9.31) Page 28 of 83

Patch 2 Release Notes
Fixed Defects



CR Problem Solution

QCCR1E77743 A legacy integration crashes with a Signal 11 error 
when running a Crystal report from 3 join tables (erddef 
and joindefs). 

The integration will not crash when running a Crystal report 
from 3 join tables (erddef and joindefs).  

QCCR1E77935 After an SLO is created, it is not attached and displayed 
in the change record. The SLO displays correctly only 
after the user logs out and then logs in again. 

After an SLO is created, it will be attached and displayed in 
the change record. 

QCCR1E78016 Trying to start multiple SM processes with the same 
httpPort simultaneously results in a memory leak. 

No memory leak will occur when trying to start multiple SM 
processes with the same httpPort simultaneously. 

QCCR1E78996 The base64Decode JavaScript function does not work 
as expected. 

The base64Decode JavaScript function now works as 
expected. 

QCCR1E78991 A Signal 11 error occurs in the 
CJsSCXmlDateTime::CJsSCXmlDateTime(double) 
function.  

Now, the CJsSCXmlDateTime object is initialized properly, 
which avoids the Signal 11 error. 

QCCR1E79306 A signal 11 occurs when changing the SQL TYPE of a 
field.

No signal 11 occurs when changing the SQL TYPE of a field.

QCCR1E79354 SM 9.30 does not send the <xop:Include> tag together 
with MTOM attachments. 

SM 9.30 sends the <xop:Include> tag together with MTOM 
attachments as expected.

QCCR1E79795 Unwanted records are returned when searching in 
"Order from Catalog" within a specified category.

Correct records are returned when searching in "Order from 
Catalog" within a specified category.

QCCR1E80092 A memory leak occurs when running command "ba" in 
the RAD debugger. 

No memory leak occurs when running command "ba" in the 
RAD debugger.
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CR Problem Solution

QCCR1E80231 When a search server becomes overloaded, Service 
Manager will hang and prevent users from continuing to 
search. Additionally, the search servers do not respond 
to the shutdown command.   

Root cause: When a search host is down or 
disconnected, the load balancer host can detect it and 
redirect search requests to the next search host. 
However, the load balancer host cannot detect if a 
search host hangs. As a result, the Service Manager 
client will try to connect and then hang too.

A new sm.ini parameter, KMSearchEngineTimeout, has been 
introduced that defines a timeout value for all Knowledge 
Management search servers (indexing, search, and load 
balancer hosts). When a timeout occurs to any host, Service 
Manager will return and report an error. 

For more information about the new parameter, see "Startup 
parameter: KMSearchEngineTimeout" on page 16.

QCCR1E80363 JAVA MAIL frequently freezes, which causes the 
eventout table to fill with unsent email. 

This issue occurs, because there is no timeout set for the 
mail sessions, which causes the RTE to wait indefinitely.  
Now, when a connection issue occurs, a timeout has been 
added so that mail can be resent when starting the sending 
process after the connection issue is resolved. 

QCCR1E83880 When you navigate to the last page after changing the 
page size, it takes a long time to show the record list.

When you navigate to the last page after changing the page 
size, it no longer takes a long time to show the record list.

QCCR1E84104 The sysinfo.get("ClientNetAddress") function returns 
an empty string when executing an external Web 
Service request. 

The sysinfo.get("ClientNetAddress") function now returns 
the correct IP address of the Web Service client when 
executing an external Web Service request.

QCCR1E84337 After upgrading to later releases of the Service Manager 
application and binary files, the functionality that 
tracked how many logins since the last reset is 
removed and this information is no longer traced in the 
operator record. 

This functionality is now implemented on the RTE side. 
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CR Problem Solution

QCCR1E84362 Accessing forms that have a virtual join that references 
a structured array may result in warning messages in 
the log that resemble the following: 

 RTE W could not find field "fielddname" in 
dbdict for file enclapplrev 

Accessing forms that have a virtual join that references a 
structured array will not result in warning messages in the 
log. 

QCCR1E84490 When the RTE detects that the IR file is corrupt, a 
Signal 11 error is received and the system crashes. 

The RTE will detect when the IR file is corrupt, and will 
prevent the crash.  

QCCR1E84567 When upgrading from ServiceCenter 6 to Service 
Manager 9, the upgrade fails with an ALTER statement 
error:  

SQL code=1741 message=ORA-01741: illegal 
zero-length identifier  
(apm.upgrade.dbdict,save.dbdict)  

The ALTER statement on cm3r and cm3t is successful and 
no SQL statement error occurs. 

QCCR1E84666 When upgrading sc6.2 to SM9.30, the inbox dbdict 
cannot be upgraded.  Instead, the Service Manager 
server hangs, you cannot log in, and the following 
information is logged repeatedly:  

RTE I Mapped field 'RECORD_KEY' to NULLTABLE 
in file 'inbox'

When upgrading sc6.2 to SM9.30, the inbox dbdict can be 
upgraded successfully.

QCCR1E84765 A signal 11 occurs when adding new SQL Table: n1 in 
dbdict. 

No signal 11 occurs when adding new SQL Table: n1 in 
dbdict.

QCCR1E87640 SCAutoListener enters an infinite loop and  leads to high 
CPU utilization.  The Service Manager session 
encounters a signal  6 and produced a core file.

Added new logic to check whether there is any  data read by 
the listener. If no data is read, quit from reading to avoid  
infinite loop.  

QCCR1E87764 A memory leak occurs when an adhoc SQL syntax is 
wrong. 

No memory leak occurs when an adhoc SQL syntax is 
wrong.
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CR Problem Solution

QCCR1E87784 When IR detects corruption, Service Manager issues 
the following, misleading messages:    

7532(  7124) 10/25/2012 23:15:22  RTE E Error 0 
in call irReadInP4 - The operation completed 
successfully.   7532(  7124) 10/25/2012 23:15:22  
RTE E irReadInP4: Failure reading 32768 bytes 
at offset scirexpert:ir.probsummary
(52409176), errno=0 (No error)   

The error messages state "The operation completed 
successfully" and "No error" which is not the case.  This 
issue occurs when the IR files are internal (that is, 
mapped to the scirexpert table). 

Now, clear messages will be provided.  If Error = 0, the first 
message will not be issued: 

"RTE E Error 0 in call irReadInP4 - The 

operation completed successfully" 
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CR Problem Solution

QCCR1E88044 A TeMIP-SM integration fails with "Out-of-Memory" 
errors or otherwise becomes unstable.  This issue 
occurs because Service Manager processes queries 
incorrectly and returns all records for the table when the 
database is frequently inaccessible.

The "Out-of-memory" error will no longer occur because 
Service Manager now returns the correct records or error 
message even if the database is frequently inaccessible.  If 
the object.name is the same as the name in the 
"extaccess" table, the correct records will be returned. If not, 
the following xml response will be returned to the client side 
and the error information will be logged in sm.log:  

<SOAP-ENV:Envelope xmlns:SOAP-ENV=

"http://schemas.xmlsoap.org/soap/envelope/">
  

    <SOAP-ENV:Body>
     

      <CreateIncidentResponse message="Specified 
Name Not Found" 

returnCode="7" status="FAILURE" xmlns="http://sch
emas.hp.com/SM/7"/>
  

    </SOAP-ENV:Body> 

</SOAP-ENV:Envelope>

QCCR1E88112 When delivery of an e-mail fails, there is no useful 
information in the log to find out the root cause.  

Now the Java stack trace will be printed to the log file if an 
exception occurs when sending an e-mail. 

QCCR1E88223 A signal 11 occurs when Service Manager calls the 
toString of an empty XML object. 

No signal 11 occurs when Service Manager calls the toString 
of an empty XML object.

QCCR1E88266 If Service Manager generates two or more core dumps 
in one thread, the last core dump will overwrite the 
previous ones. 

Service Manager now keeps the first two core dumps for one 
thread. 
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CR Problem Solution

QCCR1E88335 An attempt to add an attachment with a file name that 
ends with a dot, or an attempt to update an object that 
already has an attachment with a file name ending with 
a dot results in termination of the session with error "_
SCStringValue() pos > length". 

This issue occurs because a "." at the end of a file is 
considered as the delimiter for the extension.   Now, the 
sequence for the delimiter is "." + any character.

QCCR1E88306 A memory leak is found when you run the following 
JavaScript function:   

var r= new Record(); 

The memory leak was eliminated.

QCCR1E88305 Service Manager crashes when you run the following 
JavaScript unit test case: 

 
 function 

ClassGlobalObjectTest_testCheckObject() 

 
 {
  
   print(user); 

 
 }
  

Service Manager should not have any exception when you 
run the the JavaScript unit test case.

QCCR1E88468 After you upgrade to SM 7.11 Patch 19, a Signal 11 
error occurs and the servlets eventually hang.  

Now, the issue has been resolved by rolling back a change 
introduced in previous release.

QCCR1E88509 A memory leak occurs when performing an IR Regen. No memory leak occurs when performing an IR Regen.
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CR Problem Solution

QCCR1E88643 After you log in to Ess.do home page, you cannot 
switch to "View Closed Requests" after you click "View 
Open Requests."

This issue occurs because the RTE copies the start-up 
parameter's values to the global symbol table, so that the 
previous RAD’s start-up parameters overwrite the start-up 
values of the current RAD. This issue has been fixed.

QCCR1E88706 The SMTPMail process (also known as JavaMail) fails 
to deliver messages due to a "Not connected" 
exception error. 

The SMTPMail process (also known as JavaMail) will now 
reconnect to the session and deliver all messages 
successfully.

QCCR1E88851 When you confirm the multi-selection checkbox to 
perform a Mass Cancel, the number of records 
displayed in the confirmation message is incorrect. 

The number of records now displays correctly.

QCCR1E89009 High CPU usage and memory leak are found when the 
user sets a nonexistent SQL Type during the creation of 
a new dbdict table in an AIX+DB2 environment.  The 
memory leak is caused by a system hang that occurs 
when the user enters an unknown SQL data type.

When the user enters an unknown SQL data type, no system 
hang occurs and therefore no memory leak occurs; 
additionally, a message displays on the client side to prompt 
the user that the SQL data type is unknown. 

QCCR1E89093 When attempting to log in, users receive the following 
error and then the servlet eventually hangs:  

"Authentication failed. Contact your system 
administrator for assistance. SOAP Fault 
occurred: A signal 11 was raised in native 
code. Client terminated. Stack trace dumped 
to sm.log"  

This behavior occurs when the user tries to connect to 
the LDAP server by using SSL. 

Now, SM uses a thread-safe version of the Openldap library 
to prevent the Signal 11 error. 

 Note: On all UNIX and LINUX platforms, after applying this 
patch and before starting SM, users need to run the 
setupLinks.sh script in the server's RUN directory.

QCCR1E89219 Users cannot log in to SRC on their first or second 
attempts, despite entering the correct login credentials. 
The 3rd login attempt is successful. 

Logging in to SRC is now successful after the 1st attempt. 
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CR Problem Solution

QCCR1E89248 When you audit records, a unique constraint error 
occurs and the records are not added in Oracle. 

The primary key is generated in any case. 

QCCR1E89395 SRC server fails to start up due to the conflict between 
ESS and SRC startup. 

SRC server can start up now. 

QCCR1E89583 An SM outage occurs due to shunned messages in the 
Jgroups channel in Clustered mode. 

There will be no shunned messages because the shunning 
mode has been disabled. 

QCCR1E89717 The standard Web Service Update method responds 
with a "Record modified since last retrieved" 
message. 

The standard Web Service Update method now works well 
and no longer responds with a "Record modified since last 
retrieved" message.

QCCR1E90073 When opening a large attachment of a record 
repeatedly, the session is accumulating a large amount 
of native memory. 

The memory allocated for the attachment is released once it 
is of no use.  

QCCR1E90121 In the multi-thread email sending solution (see fix 
QCCR1E74158 in SM9.30p5), there are N 
(N=mailThreadCount) email sender threads and one 
main  email thread (reading emails from the DB); 
however, the mail-sender threads (EMAILOUT) remain 
idle in System Status. 

Now, only the main email thread is displayed in System 
Status; the mail-sender threads (EMAILOUT) are no longer 
displayed.

Note: Before this fix, there are N+1 "EMAILOUT" threads in 
System Status and the logged-in users are counted as N+1; 
after this fix, there is only one "EMAILOUT" thread and the 
logged-in users are counted as 1.

QCCR1E90160 A Signal 6 error is received and the background 
schedulers stop unexpectedly.

Fixed the issue in which a Signal 6 error is received and the 
background schedulers stop unexpectedly.  

QCCR1E90171 When you start an RTE931 instance together with an 
instance of an older RTE version that has the same 
value for the system parameter in sm.ini, the shared 
memory becomes corrupt.  This behavior results in a 
Signal 11 error, and users cannot log on to the system. 

Use the latest 921p7 and 931p2 servers. Then if the second 
server starts and finds its version is different from the first 
server, it stops itself without crashing the first server. 
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CR Problem Solution

QCCR1E90530 Users are unable to effectively process Incident tickets 
due to a loop of the "Record has been modified 
since read" message. 

The "Record has been modified since read" message 
no longer pops up. 

QCCR1E90544 You encounter a performance issue in sorted fill 
operation when record list is enabled.  

This defect is fixed. If the visual recordList is not related to 
the RELBLK, which needs to be sorted, the action to locate 
the current record is no longer performed. 

QCCR1E90546 SM process on Linux failed with a signal 6. SM RTE will not terminate the entire process if the client is 
not available to receive a message. 

QCCR1E90766 An update to a large incident ticket is slow due to the 
performance of the "recordsize"/"recordsizeok" call. 

The performance of updating a large incident ticket has been 
enhanced.

QCCR1E90767 An update to a large incident ticket is slow due to the 
performance of the "makenltt" function. 

The performance of updating a large incident ticket has been 
enhanced.

QCCR1E90842 When SM is configured to use the HTTPS URL for 
UCMDB, if you click the "View in UCMDB" button or 
expand the "Actual State" section for a CI that exists in 
UCMDB and was pushed into SM, you receive the 
following error message: 

 Error calling method: doSoapRequest in 
class: com/hp/ov/sm/server/utility/SoapClient 
Exception 
(com.sun.xml.messaging.saaj.SOAPExceptionImp
l: java.security.PrivilegedActionException: 
com.sun.xml.messaging.saaj.SOAPExceptionImpl: 
Message send failed)   

This issue does not occur if you use the HTTP URL for 
UCMDB. 

Now, View in UCMDB and Actual State work properly 
without the error message.

QCCR1E91734 In the server log (sm.log), "Unsupported Java version" 
is misspelled as "Unsupported Java verion".

The misspelling has been corrected.
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Application
CR Problem Solution

QCCR1E76724 After deleting the unique key of cm3r, a signal 
11 happened while doing an IR regeneration. 

This issue occurs because the SM server does 
not check to see if there are a unique key and IR 
key before it starts a key regeneration, and thus 
causes a signal 11.

The Service Manager server now checks if the number of 
the unique key or IR key is zero. If yes, the server then 
issues a warning message to the client that indicates the 
IR regen cannot be performed without a unique key.

To take advantage of the server fix, you must load 
QCCR1E76724_SM931P2_SM930.unl, available in the 
platform_unloads directory.

Web Client
CR Problem Solution

QCCR1E58337 Two timer widgets cannot be displayed on the 
same format at the same time in the Service 
Manager web client.

Multiple timer widgets can be displayed correctly on the 
same format in the web client.

QCCR1E60153 When you click on Change link on the CI 
Changes Tab on the CI Record, the Change is 
opened in a new browser tab with no buttons.

The Change is now opened in a new tab as expected.

QCCR1E68768 Some of our users report that the 'navigator' 
pane is empty on the left side of their screen. 
The application shows the area where the 
navigator pane must be, but it is empty.

The browser side timeout was increased to wait for the 
server response, and an unnecessary, costly request 
was removed.  This should enable the navigator pane to 
display properly.
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QCCR1E69469 You receive an “HTTP Status 404” error in the 
detail form when you perform a search in the 
web client in the following two scenarios:

1. Incident Management > Search Incidents  > 
Search

2. Service Desk > Search Interaction Records > 
Search

The "HTTP Status 404" error no longer occurs in the 
detail form.

QCCR1E70786 Multiple line comments in the subview table only 
display the first line. 

Multiple line comments in the subview table are now 
displayed correctly, with each line separated by "|".

QCCR1E71209 A "condition" option is requested that allows 
users to specify a condition under which tasks 
will be created when creating a Change Model 
that has tasks.

Added a condition editor control to edit the task condition 
for a Change Model.

QCCR1E73985 Current value of a selectonly combox will be 
cleaned up if the value is not contained in the 
value list, and no value can be selected from the 
value list when the property "Select Only" is 
activated.

The current value will be kept even if it is no longer in the 
value list.
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QCCR1E74321 MySM generates a 404 error in the SM 9.30 
Web tier when the following configuration is 
present inside the "<Host>" tag of the 
server.xml file of the Tomcat server:

<Context path="" debug="0" 
docBase="webtier-9.30">

</Context>

Users can connect to the Web client, but inside 
each of the 4 sub-windows there is a 404 error.  
This issue is present in the 9.30.201 Web tier, 
but is not present in the 9.30.021 Web tier.

Users can connect to the Web client can display the 
MySM graph when the Context path attribute of Tomcat 
is "".

Known issue of record list: Before the graph is drawn, 
404 errors will appear in each of the 4 sub-windows, but 
these will disappear shortly thereafter.

To work around this known issue, follow these steps:

 1. Create a new folder  named composition_manager in 
the \client\webtier\web\composition_manager 
directory.

 2. Copy composition the_manager\empty.html file into 
this folder.

 3. Create a new folder named images at the  
\client\webtier\web\composition_manager\ 
composition_manager directory.

 4. Copy the composition_manager\images\loading.gif 
into this folder.

 5. Verify that you have the following files in the 
directories as shown:

composition_manager\composition_
manager\empty.html

composition_manager\composition_
manager\images\loading.gif
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QCCR1E74389 After you apply Process Designer Content 
Pack, inactive Task Categories are available in 
the Change Model's Task Editor.

After you apply Process Designer Content Pack, only 
active Task Categories are available in the Change 
Model's Task Editor right now.

QCCR1E74391    The Accessible Web client uses background 
images, which cannot be read by screen 
readers.

Now an aria-label is used for a button that uses a 
background image instead of text, and its value is set as 
the button's tool tip, which can be read out by a screen 
reader when the focus is set on the button.

QCCR1E74650 Blind and disabled users use the keyboard to 
navigate in Service Manager. Therefore, it 
should be possible to use only the keyboard to 
navigate in Service Manager.  However, some 
elements, such as the register in the beginning 
of the content, table-rows and check-boxes 
(which are not done with HTML standard 
elements), can be focused with the keyboard, 
but cannot be activated by using the spacebar or 
the return key. It is therefore not possible to use 
these elements by using only the keyboard.

When working with record lists, you can do the following:

 l Use the arrow keys to go through the records.

 l Use the spacebar to select or deselect a row.

 l Use the return key to select the currently focused 
item and fill in the field.
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QCCR1E74732 Blind and disabled users must use the keyboard 
to navigate in Service Manager. Therefore, it 
should be possible to use only the keyboard to 
navigate in Service Manager. 

Important elements, such as the main and sub-
menus, the side-navigation in tables, or the tree 
structure in overviews cannot receive focus by 
using only the keyboard. These elements 
include the following:

 l Grouped lists in the ToDo queue 

 l System Navigator 

 l Page navigation (paging bar) at the bottom of 
record lists

Now the following items can get focus:

 l Group lists in the ToDo queue 

 l System Navigator

 l Paging bar of recordlist 

 Known issue: Paging bar buttons can be focused, but 
do not have a proper label, and so JAWS cannot read out 
any proper button text.

QCCR1E74831 Blind and disabled users must use the keyboard 
to navigate in Service Manager. Therefore, it 
should be possible to use only the keyboard to 
navigate in Service Manager.  However, users 
cannot sort tables by activating a column header 
with a screen reader because the "Columns" 
sub-menu is opened instead of performing the 
sort. 

When JAWS is running, users can now sort a table by 
focusing the table column header and then pressing the 
Enter key.
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QCCR1E75815 Two vertical scroll bars are appearing for 
Workflow Viewer in Normal change ticket 
forms.  

In Internet Explorer, there are no vertical scroll bars for 
workflow display, and there is no horizontal bar either.  In 
Firefox, there is no horizontal/vertical bar. 

 Note: In both Internet Explorer and Firefox, the form 
does not display well when the workflow width or height 
is bigger than the group's.

QCCR1E76531 There is no mechanism to display counters in 
the Web client in the same manner that the 
Windows client does.

For example, the Windows client displays the 
"Display list count" for a view, but nothing is 
displayed in Web client.

The record count is displayed in the Web client.

Known issue: If user update the tickets that result in the 
change of record count, the count cannot be updated 
automatically, user need click refresh button above 
navigation tree to update it.

QCCR1E78030 A skip link is not accessible with the JAWS 
screen reader, and the reading focus does not 
move to the start of the main content area.

A skip link is added on top of the page, but is only visible 
when focused. Otherwise the skip link is not visible. On 
activation, the skip link goes to the beginning of the main 
content area, ahead of detail tab header.

QCCR1E78176 When you set the main menu to SC style after 
you log in, a JavaScript error is received.  
Additionally, groups cannot be expanded 
automatically.

There is no JavaScript error in the main menu page, and 
the first group is expanded by default.

QCCR1E78246 Dashboards in SM 9.30 are a lot smaller than 
SM 7.11.

This issue occurs because the chart size in SM 9.30 was 
calculated incorrectly. The issue is now resolved.

QCCR1E78594 You cannot remove the condition once it has 
been added using the Condition Editor.

Now you can remove the condition using the Condition 
Editor.

QCCR1E78687 When you tab to a selected Provider Group and 
then click on a collapsed item, the focus does 
not remain on the expanded item.

You can now expand and collapse groups without losing 
focus, and the state change is read by JAWS.
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QCCR1E78734 Us.print does not function correctly when called 
from a display option in the Web client. Instead, 
a "Loading" message appears briefly and then 
nothing more occurs.  When called from the 
Windows client, the print dialog is displayed as 
expected.

Now, the print window is displayed as expected when 
us.print is called.

QCCR1E79007 Only the first element of a comfill displays in a 
Virtual Join when the "Display Using Table" 
option is off.

All elements of a comfill display correctly in a Virtual Join 
when the "Display Using Table" option is off.

QCCR1E79114 A data changed event fires too late when the 
focus leaves a radio button in the Web client 
running in Internet Explorer.

The data changed event fires properly when the focus 
leaves a radio button in the Web client running in Internet 
Explorer.

QCCR1E79125 The navigator size is not remembered after the 
user logs out of the system. 

The navigator size is now remembered when the user 
logs out.

QCCR1E79203 When you click the icons above the Navigator in 
9.30.P4.HF3, the JAWS screen reader returns 
an "Unlabeled 0 button" message.

Add accessibility support for the Manage Favorites, Add 
Favorite, Refresh, Collapse/Expand Navigator, Spell 
Check, Print Page, Messages and Alerts icons and 
buttons.

QCCR1E79204 In 9.30.P4.HF3, the icons above Detail form bar 
cannot be read by JAWS13.  Instead, JAWS 
identifies them as 'Unlabled 0 Buttons".

Add accessibility support for the Manage Favorites, Add 
Favorite, Refresh, Collapse/Expand Navigator, Spell 
Check, Print Page, Messages and Alerts icons and 
buttons.

QCCR1E79212 Messages are read only if a user triggers the 
Read All command (Ins+B) after the message is 
displayed.

"Role=alert" and "aria-live=assertive" are now used to 
indicate updated areas on the page, and the screen 
reader now reads the messages immediately.
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QCCR1E79205 JAWS 13 cannot read the Collapse/Expand 
status of the tree node of Navigator or whether 
the items of the navigator tree can be expanded 
in 9.30.P4.HF3.

Accessibility support was added for the navigation tree 
so that JAWS can read the Collapse/Expand status of 
tree nodes, and use the arrow keys to navigate the tree.

QCCR1E79369 When tailoring RuleSet RAD Expressions by 
using Process Designer and using the 
ampersand (&) special character in the condition 
expression of RuleSet, the following error is 
received:

Error "Expression can't be edited because data 
is missing or corrupt"

Tailoring the RuleSet RAD Expressions now works as 
expected, even when you use the ampersand (&) special 
character in the condition expression of RuleSet.

QCCR1E79399 The expanded or collapsed state of the 
navigator cannot read by the JAWS screen 
reader.

The expanded or collapsed state of the navigator can 
read by the JAWS screen reader.

QCCR1E79484 In classic login mode, the screen reader does 
not tell the user whether the menu in details is 
expanded or collapsed.

In index mode, the title and alt values of the image are 
updated according to the state of the current menu.

 l If the current menu is expanded, the values are 
“Collapse Menu”.

 l If the current menu is collapsed, the values are 
“Expand Menu”.

In accessible mode, since the menu cannot be 
collapsed, the title and alt values of the image are set as 
"Menu".

QCCR1E79534 The calendar widget icon is not rendered in an 
array table from the CM.change.login form.

The calendar widget icon is now rendered correctly in an 
array table.
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QCCR1E80228 Users cannot see the graphical relations about 
CI's in the Service Manager Web client when 
the web application server's context path is of a 
multi-level structure, such as "/sm/sm921". 
Instead, the graph is always empty.

Users can now see the graphical relations about CI's in 
the Service Manager Web client.

Known issue:

If the web application server's context path is of a multi-
level structure, such as "/sm/sm921", MySM pages 
cannot be displayed and an error occurs. To resolve this 
issue, perform the steps below to update the records in 
the "uimcompdefinitions" table.

 1. In Database Manager, type "uimcompdefinitions" in 
the Table field, and click Search.

 2. Click Search to retrieve a list of records in the 
"uimcompdefinitions" table.

 3. For all the records, add the additional context path 
as a prefix to the "View Url" and "Filter Url" fields. 
For example, if the custom context path is 
"/sm/sm921" and the value of the "View Url" field is 
something like "/uimComponent.jsp?ctx=chart&…", 
change the value to "/sm921 
/uimComponent.jsp?ctx=chart&…".

 4. Save the records.

 5. Log off Service Manager and log back in for the 
changes to take effect.

QCCR1E84713 When you add different dates in the Parts and 
Labor section on the Web client, the date and 
time value of the first line changes after the date 
and time values of other lines are changed.

Dates are now updated in the correct rows.
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QCCR1E88062 A subform that contains a table component 
shows only the first element in Admin mode.

All elements are now shown as expected.

QCCR1E88074 When there is a form with collapsible sections in 
a collapsible section on the Web client, the 
space between the section header and the next 
section is not suppressed after you expand and 
then collapse a section.

To resolve this issue, the height is reset to the new value 
on either expand or collapse.

QCCR1E88267 Change models should have a flag that allows 
users to specify whether a task is 
editable/removable in the task planner of a 
change record. The default value should be 
false.

Users can now specify whether a task is editable or 
removable. This was achieved by adding a mandatory 
checkbox in task planner in change models.

QCCR1E88461 In the ESS client, a 404 error occurs when the 
user attempts to open an attachment.

In the ESS client, now you can open an attachment 
successfully without any errors.

QCCR1E88872 In Service Manager 9.30, the charts are partially 
cut off from the bottom and the auto-resizing 
functionality does not appear to work correctly.

Note: This behavior does not occur in the 
SM7.1x code branch.

The chart sizing behavior is now the same as SM7.1x.

QCCR1E89021 The focus gets lost after the user presses the 
Enter key on Navigation toolbar buttons and 
Favorite toolbar buttons. 

The focus now remains on the Navigation toolbar buttons 
and Favorite toolbar buttons.

QCCR1E89261 The Web client hangs when you return from the 
Change Detail page to the Interaction page.

The Web client no longer hangs when you return from the 
Change Detail page to the Interaction page.
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QCCR1E89653 Superfluous error messages occur in the Web 
client when a referenced workflow name 
contains characters that are not in the English 
Latin character set.

No error message occurs in the Web client when a 
referenced workflow name contains characters that are 
not in the English Latin character set.

QCCR1E89789 The Notebook widget can be rendered as Group 
by selecting the "Group rendering enabled" 
property in Forms Designer. However, there is 
no mechanism to easily customize notebook 
rendering style for the entire system.

The Lock rendering style property has been added to 
the Notebook widget in Forms Designer, and the default 
value of this property is "True".

This property is designed to work with the following two 
options that will be added in the upcoming Process 
Designer Content Pack. If you have not installed the 
corresponding Process Designer Content Pack, ignore 
the "Lock rendering style" option. Otherwise, refer to 
Release Notes of that Process Designer Content Pack 
for details.

 l Preferred Notebook Style option under System 
Administration > Base System Configuration > 
Miscellaneous > System Information Record

 l Preferred Notebook Style option in  Operator 
records. If this option is not empty, the Preferred 
Notebook Style setting in System Information Record 
is ignored.

Note: When Lock rendering style is True, the 
above two settings are ignored.
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QCCR1E89790 Group rendering in the Web client needs to be 
improved for the Notebook widget.

The following improvements are introduced in the group 
rendering for the Notebook widget in the Web client :

 l Added a line break between groups to separate 
different groups (To make the style consistent with 
the Group widget).

 l Only the groups that have the "Default to Expanded" 
option checked are expanded by default.

Limitation:

Nested notebooks that are rendered as a group in the 
Notebook widget are not recommended. If you have to 
do that, adjust the "Height" property of the outside 
Notebook widget to make it high enough to enclose the 
nested expanded groups.

QCCR1E89766 On the 9.31 Web client, when you select the 
"Show clocks" option from a record that has an 
active clock, there is JavaScript error and a 
blank screen is shown.

The list of clocks now shows correctly when you use the 
"Show clocks" option in the Web client.

QCCR1E90051 The Condition Editor does not support a blank or 
null value for a Number/Date type field.

A Blank/Null option is now available from the drop-down 
list of the Condition Editor.

QCCR1E90275 When a list-only page (a ToDo list or Fill list) is 
initially opened or reloaded (resorted or 
refreshed), the first row or the last selected row 
is selected.

When a list-only page (a ToDo list or Fill list) is initially 
opened or reloaded (refreshed or resorted), the first row 
or the last selected row is only focused but not selected, 
regardless of the viewrecordlist setting. 

QCCR1E90292 In Task Planner, tasks in waiting state and 
tasks in active state use the same style.

In Task Planner, tasks in waiting state use a new style, 
which is different than that of active tasks.
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QCCR1E90581 If you use a proxy to connect to Service 
Manager, you do not receive the “record locking” 
message when you try to modify a locked IM 
record.

This defect is fixed. The “record locking” message is 
displayed correctly.

QCCR1E90655 Timer widget "Expiration Event" property is not 
triggered in the ESS web client.

Timer widget "Expiration Event" property works correctly 
in the ESS web client.

QCCR1E90797 The date/time picker for the Start Time field and 
the End Time fields is missing when the 
corresponding field has a value.

The date/time picker is visible when the corresponding 
field has a value. 

QCCR1E90960 The phase names text does not align correctly in 
the phase rectangles in Workflow Viewer.

The phase names text now aligns correctly in the phase 
rectangles in Workflow Viewer.

QCCR1E91012 After a new change task is saved, the date/time 
picker for the start time and the end time in the 
work notes group disappears if values are 
provided for these two fields.

After a new change task is saved, the date/time picker 
for the start time and end time in the work notes group 
does not disappear if values are provided for these two 
fields.

QCCR1E91026 The check box in the header of a grid is not 
removed after a page is refreshed.

Now, the check box in the header of a grid is removed 
after page is refreshed.
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QCCR1E91172 When you create or edit a rule set, it is a simple 
process to re-sequence individual rules. 
However, there is no way to re-sequence rule 
sets that have been applied to a phase. If you 
need to add another rule set that must be 
executed first in the rule set list for a phase, 
currently there is no way to add it or move it to 
the top of the list. Instead, you have to drop all 
rule sets and re-add them in the proper order. 

The Up and Down arrow buttons have been added to the 
web tier's Workflow Editor so that you can move a rule 
set up or down.

To change the order of rule sets:

 1. Navigate to Tailoring > Process Designer > 
Workflows.

 2. Open an existing workflow.

 3. Select a phase or a transition in the workflow.

 4. Go to the Rule Sets or Actions tab (for a Phase) or 
the Rule Sets section (for a transition), add rule sets 
to the list if needed.

 5. Select a rule set from the list, and click the Up or 
Down arrow button to move it up or down.

QCCR1E91169 When you change the description of an existing 
change task in the task planner, if you click at 
the middle of the text and start typing, the cursor 
unexpectedly moves to the end of the text after 
you type the first letter.

Now, the cursor no longer moves to the end of the text 
when you try to insert characters in the middle of the 
existing description.

QCCR1E91189 If you use the CTRL key to copy a task, after 
you modify the copied task, the original task is 
also changed.

This defect is fixed by disabling the clone feature.

QCCR1E91176 In the task planner, the task description that 
contains only numbers is displayed incorrectly 
in the graphic.

Now, the task description is displayed correctly in the 
graphic of the task planner even if the description only 
contains numbers.
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QCCR1E91187 In the task editor, if you press the Enter key 
when editing Task-Properties, the page 
refreshes without saving the task so that the 
changes you made are lost.

This defect is fixed by disabling the Enter key in the task 
planner window.

QCCR1E91173 If a task condition is set with a less than (“<”) 
symbol, the expression after the "<" symbol 
disappears when you save the condition.

Now, you can save a condition containing the less than 
(“<”) symbol with the complete expression.

QCCR1E91228 When the focus is set on a subgroup record in a 
record list, if you resort the list multiple times 
and then click the Select All checkbox, no 
record is selected. 

All records in the record list are selected.

QCCR1E91626 The image of the Mass Cancel button is missing 
in the Web client after you apply Process 
Designer Content Pack 3 (PDCP3).

The image of the Mass Cancel button displays correctly 
after you apply PDCP3.

QCCR1E91632 Users cannot drag or drop Task Planner in 
Internet Explorer.

Users can drag or drop Task Planner in Internet Explorer.

QCCR1E91647 When you open the Task Planner, all buttons on 
the detail form toolbar are disabled; if you click 
another record in the list page, all the buttons are 
still disabled. 

If you click another record in the list page, all the buttons 
are enabled.

QCCR1E92065 On the Web client, the "select all" check box for 
list cannot be unchecked with mouse if it has 
been checked by the Space key.

The "select all" check box for list now can be checked or 
unchecked by using mouse or the Space key freely. 

QCCR1E92078 The Service Manager client does not support 
Hebrew localization.

Hebrew localization text strings are now shown with the 
Hebrew locale.
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CR Problem Solution

QCCR1E49805 In Forms Designer, the "Web Preview" 
widget does not display the 
information.

In Forms Designer, the "Web Preview" widget displays the correct 
information.

QCCR1E52188 The HTML Editor in the Knowledge 
Management KM Contribute 
Knowledge screens does not display 
when using a Shared Service Manager 
Client type.

This defect is fixed. The HTML Editor displays correctly when using a 
Shared Service Manager Client type.

Known limitations:

Some files are copied to the "C:\Documents and Settings\{your user name}
\ServiceManager\workspace\.metadata\.plugins\com.hp.ov.sm.client.eclips
e.user\htmlEditor" folder.

Therefore, the first time when you open a window that contains HtmlEditor 
widget, it will be slower than before.

Additionally, since some files’ path length may exceed 255, you cannot 
delete them directly. In this case, you can use DOS commands to delete 
these folders. Go to the "C:\Documents and Settings\{your user name}
\ServiceManager\workspace\.metadata\.plugins\com.hp.ov.sm.client.eclips
e.user" folder, and then execute the "rmdir /s/q htmlEditor" command to 
delete the whole htmlEditor folder.
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QCCR1E53130 After you change the font size or select 
the Restore Defaults from Window > 
Preferences > Appearance on the 
Windows client, the format no longer 
fits on the screen. This results in 
objects falling off the edge of the form 
and the vertical and horizontal scroll 
bars are not created.  This behavior 
prevents users from navigating the 
form.

Now the scroll bars are shown as expected when a larger font is used.

QCCR1E64130 When you select a record from the 
Incident Queue in the Windows client, 
you experience poor performance and 
then you receive a SOAP error.  This 
issue occurs when you have grouping 
enabled and a large number of records 
returned.

The Windows client responds much quicker when you select a record from 
the Incident Queue with grouping enabled and a large number of records are 
returned.

Known issue:   This resolution targets group views only.  You may still find 
performance issues on non-group views.
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QCCR1E65333 If the Delete button is used to remove 
an attachment from a record, it also 
removes any text that was previously 
highlighted. Specifically, this issue 
occurs only in the Windows/Eclipse 
client, and requires the following, 
specific set of steps in the SM 7.11 
user interface:

 1. Open any ticket with an 
attachment.

 2. Note the field that is highlighted 
when the ticket is opened.

 3. Select the attachment.

 4. Press the delete key. The 
attachment is deleted and the field 
that was highlighted when the 
ticket was opened is cleared.

It appears that clicking on the file name 
does not un-select the highlighted field.

When you press the "delete" key on attachment, the selected text will no 
longer be cleared.
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QCCR1E73858 The SM9.30.201 build (Patch 3) 
Windows client cannot open 
attachments that have a long filename 
(more than 120 characters).

The Windows client can open attachments that have long filenames.

Note: Due to the limitation of file name length (255 characters) in Windows 
systems, follow these guidelines:

 l Use a short filename for attachments, and

 l Make the path length as short as possible if you want to change the 
default workspace for the Windows client.

QCCR1E76437 The Form Designer Web Preview does 
not work if the form contains collapsed 
content.  You cannot expand the 
content in the collapsed section in 
preview window.

You can expand sections as expected in the Web Preview window.

QCCR1E79222 When a session is terminated, the user 
receives a "Session no longer valid" 
message on every open tab. This is 
annoying when multiple tabs are open.

When a session is terminated, the user receives only one "Session no longer 
valid" message.

QCCR1E83715 The us.launch.external RAD 
application does not open the browser 
if the ToDo tab is closed.

The us.launch.external RAD application opens the browser even if the ToDo 
tab is closed.

QCCR1E83940 When you double-click a record in the 
record list to select it, additional 
actions may occur on the detail format.  
This behavior occurs if, when you 
double-click the record, the mouse 
position is where an interactive 
element of the detail format (such as 
Link Label or button) will appear.

The issue has been fixed so that the detail format is opened without triggering 
additional actions.
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QCCR1E88876 In Service Manager 9.30, data charts 
placed above a record list are partially 
cut off from the bottom and the auto-
resizing functionality does not appear 
to work correctly.

Note: This behavior does not occur in 
SM7.1x.

The graph sizing behavior is now the same as in SM7.1x.

QCCR1E89544 Printing a non-grouped record list does 
not work on the Windows client. For 
example, the Incident record list that 
displays when you select Incident in 
the To Do queue and select 
Autoformat Date View in View.

Printing a non-grouped record list now works well.

QCCR1E91040 Forms Designer crashes if you save a 
form that contains a notebook of which 
at least one tab is invisible.

Forms Designer no longer crashes if you save a form that contains a 
notebook of which at least one tab is invisible.  

Known Issue: When you switch the form from Design mode to Preview 
mode in Forms Designer, the focus is no longer always set on the first visible 
tab of the Notebook.

QCCR1E91837 The image of the Mass Cancel button 
is missing in the Windows client after 
you apply Process Designer Content 
Pack 3 (PDCP3).

The image of the Mass Cancel button displays correctly after you apply 
PDCP3.

QCCR1E92046 In the Properties pane of Forms 
Designer, if you click a dropdown list 
(for example, the "Foreground Color 
Condition" dropdown list) multiple 
times, single mouse click no longer 
works. You have to use double-click 
instead of single-click.

This defect is fixed. Single-click works.
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KM Search Engine
This release fixes the following defect in the KM Search Engine.

CR Problem Description

QCCR1E90386 Need to certify JDK7 on the KM Solr Search 
Engine, because JDK 6 reached its EOL in 
February 2013 and the KM Solr Search Engine 
heavily relies on JDK. 

JDK 7 Update 17 has been certified on the KM Solr 
Search Engine.  Pay attention to the following: 

For Windows platforms, after updating to JDK 7, do the 
following: 

 1. Replace startup.cmd and installservice.cmd in 
the kmsearchengine directory with the files in the 
KM patch.

 2. Restart the Solr search engine. KM search should 
work fine.  

For UNIX platforms, you do not need to change any files; 
simply restart the KM Solr search engine after your JDK 
is updated.
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Known Problems, Limitations, and Workarounds
This software release has the following known issues and limitations.

Global ID Problem Workaround

QCCR1E63663 The Service Manager (SM) client loses 
connectivity during JavaScript 
execution of the file.list RAD 
application.

No workaround available.

Created a knowledge article (KM1166532), which states that Service Manager 
does not currently support calls from JavaScript on RAD applications that use 
the rio/fdisp panels.
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Global ID Problem Workaround

QCCR1E57385 When Service Manager is running on 
Unix, the legacy listener may log 
intermittent signal 11 upon CIT initial 
connectivity test if exec-shield is not 
set properly.

Use one of the following solutions to solve this issue on Unix.

Solution 1:

Connect Connect-It to the Web Services connector instead of the Legacy 
Listener connector.

Solution 2:

Before connecting Connect-It to the Legacy Listener connector, do the 
following:

 1. Add  usethreading:0 in the sc.ini file, which is located in <Service Manager 
server installation path>\LegacyIntegration\RUN.

Note: For 64-bit RedHat Linux servers only, you can alternatively run the 
following shell commands as root:

# sysctl -w kernel.exec-shield=0

# sysctl -w kernel.randomize_va_space=0

 2. Start the legacy listener.

QCCR1E69449 The user encountered a signal 11 while 
updating an incident: RTE E Caught 
XML API exception scxmlapi(40).

This is because another user was 
updating the probsummary dbdict 
record at the same time.

When modifying a dbdict record, ensure that there are no other users updating 
records or inserting records in the same file. For example, when updating the 
probsummary dbdict, make sure that there are no other users updating existing 
incidents or opening new incidents. 
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Global ID Problem Workaround

QCCR1E67491 When the collation of the db instance 
is Chinese_PRC_BIN, Web service 
clients fail to connect to Service 
Manager (SM). Only ASCII operator 
names are supported, so only ASCII 
operator names can be used. 

Note: This issue only exists in Web service integrations. Therefore, the SM 
clients do not have this problem.

When SM is handling an incoming SOAP request, the authorization string is 
decoded by BASE64Decoder. SM uses the decoded string value to construct a 
UTF-8 string that is used in the RTE. However, the authorization string is in the 
header and SM does not know the charset or encoding of the underling string 
value, which is BASE64 encoded. 

Therefore, if the underlying string value is not UTF-8 this problem will occur. In 
SM, when fetching an operator record from the database, no matter what 
collation the database uses, the operator record finally will get a UTF-8 operator 
value. However, even if users put the same value in the authorization header, 
the operator name may differ because of the charset/encoding issue. Because 
of this, the operator will fail to log on.  

This is a limitation of SM. Do not use non-ASCII characters in operator names. 
Created a knowledge article (KM1442479) to document this limitation. 

QCCR1E75182 HTML email truncates the body of the 
message and sends the HTML code 
without translating it.

When the content of an HTML email template exceeds 8192 bytes in size, the 
content will be truncated and displayed as HTML code.   

Make sure your HTML email templates do not exceed this size limit.

QCCR1E89890 Grouped Views are not correctly 
updated after logging a new Incident.  

When you log a new incident, to keep consistency with actual incidents, the 
group number is not updated. 

You need to click the "Refresh" button to update grouped Views.

QCCR1E72835 Add the ability to limit the memory 
consumed by individual threads in SM 
as specified by an Administrator.

The requested change is not implemented to avoid performance degrade.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E77563 Signal 11 error is received when calling 
the toXMLString() routine of the Users 
object. 

HP has reviewed this change request. After careful consideration regrettably 
HP has determined the requested change will not be addressed within the 
product.

No workaround is currently available.

QCCR1E77657 When using Mobility on a BlackBerry, 
users are taken to a back screen after 
entering comments for an Approval 
and then clicking the Back button. 
However, users should be returned to 
the Change queue.

HP has reviewed this change request. After careful consideration regrettably 
HP has determined the requested change will not be addressed within the 
product.

QCCR1E88222 An unload file that is exported from an 
Oracle to an SQL Server database fails 
to import when the unload file already 
contains a RECORD_KEY field and 
the length of first unique key exceeds 
the db limitation.

This request is caused by the product running in an unsupported configuration. 
Change to a documented and supported configuration. If the problem still exists 
in a supported environment, contact HP Support.

To work around this issue, do not use "RECORD_KEY" as a SQL Name for a 
field in dbdict.  This field name is reserved by SM.  To do this, follow these 
steps:

 1. Enter dbdict in the SM command line box.

 2. Enter "esdquestions" in to the search field, and then click the Search 
button.

 3. Select the "record.key" field, and then change the SQL Name from 
"RECORD_KEY" to anything else.

HP Service Manager (9.31)Page 62 of 83

Patch 2 Release Notes
Known Problems, Limitations, and Workarounds



Global ID Problem Workaround

QCCR1E99940 Customers on Solaris 9 cannot 
upgrade to SM9.31p2 or a later patch 
because JRE7 does not support 
Solaris 9 and Service Manager starts 
with a JRE validation that does not 
allow a JRE version below JRE7 up15.

To continue to use JRE 1.6 on Solaris 9, modify the following three lines in the 
validjava.sh file located in the SM server's  RUN/ folder.

From: 

JAVA_UPDATE_VERSION_SUPPORTED=15

To: 

JAVA_UPDATE_VERSION_SUPPORTED= 20

From: 

if [ "${JAVA_VERSION}" = "1.7" ]; then

To: 

if [ "${JAVA_VERSION}" = "1.6 " ]; then

From: 

echo "Install or setup Java 7 correctly and then run 
./setupLinks.sh to re-create the symbolic links."

To: 

echo "Install or setup Java 6   correctly and then run 
./setupLinks.sh to re-create the symbolic links."
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Documentation Errata
The following documentation items are incorrect. 

Location:

Online help: Help topic "Subform control" 

Error: :    

This topic needs more information about using the Input property.

Correction:

The Input property description should be updated as shown in the following:

Property Description

Input Specify the database field or variable to associate with this control. 

Tip: If the database field is a complex type, for example, Array type or Structure 
type, you must specify the Input property using this format: 
ArrayName,FieldName. For example, recorded.changes,old.scalar.

Location:

Online help: Help topic "Startup parameter: emailout" 

Error:  

The following note in this help topic is no longer correct due to server fix "QCCR1E90121" on page 
36:

"Note: The main email thread now reads email records from the database and places them in a 
queue, and some number of other threads (N=mailThreadCount) send the emails from the queue. 
Therefore, there are N+1 "eventout" entries in System Status instead of one entry, and the logged-
in users are counted as N+1 instead of 1."

Correction:

The note should be changed to the following:

"Note: The main email thread now reads email records from the database and places them in a 
queue, and a number of mail-sender threads (N=mailThreadCount) send the emails from the queue; 
however, there is only one "EMAILOUT" thread entry displayed in System Status and the logged-in 
users are counted as  1, because the mail-sender threads are internal threads and are therefore not 
displayed."
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Backout Instructions
If you want to restore your Service Manager system to its original state after installing this patch, 
follow these guidelines.

Server
To backout your server changes, make a backup before installing the patch and then roll back.

Backup
Before applying the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.30\Server.

Backout
After installing the patch, do the following to backout:

 1. Remove the existing server installation folder.

 2. Copy the backup folder back.

Web Tier
Backup

Before deploying the new web tier, make a backup of the following items:

 l web.xml file

 l application-context.xml

 l splash screen

 l style sheets

 l any other customizations you made, including your webtier-9.31.war (webtier-ear-9.31.ear) file.

Backout
To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.
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Windows Client
To roll back to your old Windows client, you need to do backup before installing the new Windows 
client and then reinstall the previous Windows client. 

Backup

 1. Make a backup of your Windows client home folder, for example, 
C:\Users\<username>\ServiceManager. Your connections and personalized settings are 
stored in this folder.

 2. Make a backup of your security configuration files if any (Window > Preferences > HP 
Service Manager > Security). For example, your CA certificates file and client keystore file. 

Backout

 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

Applications
Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to make a backup of the files to be modified by an 
unload file, because Unload Manager can create a backup of your old data during the 
installation of the unload; if your application version is other than any of these, Unload Manager 
is not available and you can use Database Manager instead. 

To use Unload Manager to make a backup:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.
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 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:

 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and 
browse to the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this 
unload.

See the following figure for an example.

This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.
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File Record

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict 
record of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the 
Search button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.

 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in 
Database Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is 
not available in your application version) to roll back to your old data, as described in the 
following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click 
Next. Details of the unload file display.
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 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:

 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.

 3. Click Load FG.
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Installation Notes
This section provides instructions on installing each component in this patch release.

Digital Signature Notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has 
been updated to use a new VeriSign root certificate. On a Windows system that does not have the 
new VeriSign root or intermediate certificate installed, when the user right-clicks the file and then 
goes to Properties > Digital Signatures > Details, a verification error will display: “The certificate 
in this signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate 
as documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140

Web Tier Installation
The Web Tier update consists of a compressed file, sm9.31.2004-P2_Web_Tier.zip. The specific 
upgrade process depends on your particular Web application server, but follows the same steps as 
deploying a new installation. For more information, refer to the Service Manager Interactive 
Installation Guide.
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The upgrade does not automatically save your Web Tier customizations. To keep your changes, 
you must save your customized files and replace the new version of these files with your 
customized version.

Note on Tomcat 7.0: If you plan to deploy the web tier on Tomcat 7.0 using the Tomcat Manager, 
be sure to set the max-file-size and max-request-size parameters (default: 52428800) in the 
<Tomcat 7.0_Home>webapps\manager\WEB-INF\web.xml to an appropriate value greater than the 
web tier .war file size; otherwise the deployment request will be rejected because the web tier .war 
file exceeds the default maximum values. This restriction does not exist in Tomcat 6.0.

To install the new Web Tier:

 1. Make necessary backups. For details, see "Backout Instructions" on page 65.

 2. Delete or uninstall the existing webtier-9.31.war (or the .ear) file.

 3. Clear the cache of your web application server (for example, Tomcat).

 4. Deploy the new webtier-9.31.war (or the .ear) file following the instructions in the Service 
Manager Installation Guide.

Note: It is best practice to deploy with a unique context root. For example: /webtier-9.31.2004

 5. Use a diff utility to compare the new Web tier’s web.xml file against your backed-up version to 
ensure that any new parameters are properly merged into the files used in your final 
deployment. Do this for application-context.xml as well as any other files you may have 
customized (such as style sheets and splash screens).

 6. Make any new customizations necessary for your deployment. 

 7. Restart the web application server.

Note: Before accessing the new Web Tier, HP recommends that all users empty their 
browser cache.

Windows Client Installation
The Windows client update consists of a compressed file, sm9.31.2004-P2_Windows_Client.zip, 
which contains the executable installation files.

To install the Windows client update:

 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backout Instructions" on page 65.

 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)
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 4. Run setup.exe and install the client by following the instructions in the Service Manager 
Installation Guide.

 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.31.2004.

Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.31.2004-P2_
<OS>.zip (or .tar), which contains the Service Manager server files. These files add to or replace 
the files in the [SM Server Root]\ ([SM Server Root]/) RUN, irlang, 
legacyintegration, and platform_unloads directories.

Upgrade Paths
This server patch must be applied on top of one of the following versions/patch levels of the SM 
server:

 l SM9.30 GA

 l SM9.30 Patch/Hotfix

 l SM9.31 

 l SM 9.31 Patch/Hotfix

The following server upgrade paths are recommended:

 l New customers: Install the SM9.30 GA server, and then directly apply the latest 9.31 server 
patch;

 l Existing SC6.2, SM7.11 and 9.21 customers: Uninstall the old server, install the SM9.30 GA 
server, and then apply the latest 9.31 server patch;

 l Existing SM9.30 or 9.31 customers: Apply the latest 9.31 server patch.

For installation instructions of the SM9.30 GA server, see the Service Manager 9.30 Interactive 
Installation Guide, which is available from the HP Software Manuals Site: 
http://h20230.www2.hp.com/selfsolve/manuals

For installation instructions of the server patch, see "Server Patch Installation Steps" below.

Server Patch Installation Steps

Note: If you have a load balanced system, you must upgrade all server instances.
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Caution:   

 l This server update will upgrade the embedded Tomcat to version 6.0.36, and therefore 
requires additional steps.

 l Starting with SM9.31p2, the SM server requires JRE 1.7. For Windows and Linux, the 
embedded JRE has already upgraded to version 1.7; for other Unix-based platforms, you 
need to manually perform this JRE upgrade.

The JRE upgrade will cause external web service calls over SSL to fail if the remote 
endpoint does not support Server Name Indication (SNI), which is by default activated in 
JRE 1.7. Once Service Manager is upgraded to use JRE 1.7, it starts to use SNI 
extensions during the SSL handshake. If the remote endpoint does not support SNI, the 
web service call will fail with an error message. To solve this issue, do either of the 
following:

 n Activate SNI at the remote end point (recommended)

 n If the remote endpoint does not support SNI extensions, and SNI cannot be activated, 
add the following JVMOption<n> parameter either to the sm.ini file, or to the start 
command of the servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

To install the Server update:

 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backout Instructions" on page 65.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.36 
when you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory.

The purpose of this step is to avoid conflicts between the old 1.6-based JRE and new 1.7-
based JRE.

 7. Extract the compressed files for your operating system into the main Service Manager 
directory on the server. The default path is: C:\Program Files\HP\Service Manager 
9.30\Server.

 8. For UNIX servers, set the file permissions for all Service Manager files to 755.

 9. For UNIX servers, manually upgrade to JRE1.7.
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 a. Install either JDK1.7 or JRE1.7 for your specific platform.

Solaris JRE1.7 (update 15  or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)

AIX JRE1.7 (SR4 or greater)

 b. Set your JAVA_HOME environment variable to point to JDK1.7 (if you have 
JDK1.7 installed) or JRE1.7 (if you have only JRE1.7 installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links. 

 d. Run the following command to check that the JRE version is 1.7: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them 
in the new RUN/tomcat folder.

 11. If you were running a server earlier than version 9.31, your old schemastub.xml file (in the <SM_
Server_Home>\RUN\km\styles\ directory) has been updated to a new version. If you want to 
use the new KM Solr search engine features, follow the steps described in the Solr Search 
Engine Update Installation section; otherwise, copy your old schemastub.xml file back.

Note: The schemastub.xml file is same with the one shipped with SM9.31 or 9.31p1.

 12. Make sure the server is stopped, and run the sm -unlockdatabase command.

Note: The purpose of this step is to prevent stale license information from being kept in 
the system. In a scaling implementation, you can run this command from any one of your 
servers.

Caution: This step is required the first time you upgrade to 9.30p4 or later; it is also 
required whenever you change the server’s IP address after your upgrade to 9.30p4 or 
later.

 13. Restart the Service Manager server.

 14. Restart the Service Manager clients.

 15. Check the version in Help > About Service Manager Server. The server should be Release: 
9.31.2004.
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Application Unload Installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the 
relevant issue, an unload file is provided. Unload files introduced in earlier patches are also included 
in this cumulative release. If you have not already applied them for a previous patch, you should 
also apply the unload files that are intended for your applications version. For more details about 
these applications updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract 
sm9.31.2004-P2_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order, unless otherwise specified.

Unload File Naming Convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For 
example, QCCR1E12345. Note that this is always the number of the parent CR of a CR family 
(if any).

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For 
example, SM921P2, which means the unload file comes with the server updates in Service 
Manager 9.21 patch 2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example, 
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 patch 
16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, 
SM711, which means the unload file is intended only for Service Manager applications version 
7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 
example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 
9.20, and 9.30 (which are compatible with Service Manager server 9.30), unless otherwise 
specified in the unload file description. For information on the applicable applications versions for 
each unload file included in the current patch, see "Unload Files Included in the Current Patch" 
below.

Unload Files Included in the Current Patch
The following are unload files included in the current patch release.
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Unload file

Introduc
ed in  
9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E7672
4_SM931P2_
SM930.unl

9.31p2 9.30 and 
9.31

Fixes the issue that after deleting the unique key of 
cm3r, a signal 11 happened while doing an IR 
regeneration.

Associated server fix: "QCCR1E76724" on page 28

QCCR1E7622
7_SM930P6_
SM930.unl

9.31 9.30 Contains the code changes to support localization of 
incident/change priority and urgency strings for the 
Mobility Client.

QCCR1E7879
4_SM930P6_
SM930.unl

9.31 9.30 Removes incident.assignee when a Web Service call 
specifies the assignee as 'NULL' via the Mobility 
Client.

QCCR1E7679
6_SM930P6_
SM930.unl

9.31 9.30 Provides the ability to turn on debugging dynamically 
for user sessions or schedulers.

Note: This unload requires the SM9.31 server.

QCCR1E7109
9_SM930P5_
SM711.unl

9.30p5 7.11 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when adding 
a field by using Modify Columns.

Associated server fix: QCCR1E71099

QCCR1E7109
9_SM930P5_
SM920.unl

9.30p5 9.20 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when adding 
a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E7109
9_SM930P5_
SM930.unl

9.30p5 9.30 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when adding 
a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E7113
9_SM930P5_
SM930.unl

9.30p5 9.30 Works with server fix QCCR1E71139 to solve this 
issue: When Service Manager is configured to use 
LDAP as the authentication data source, the user is 
still forced to change the password if the user is 
expired in the local database.
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Unload file

Introduc
ed in  
9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E3194
1_SM930P4_
SM930.unl

9.30P4 9.30 Enables users to use a pre-configured decimal 
symbol when completing numeric fields. 

Note: This enhancement requires a 9.30p4 or 
later server; however if you are using RTE 
version 9.30 with applications version 7.11 or 
9.20, do not load this unload file; you can safely 
upgrade your server to 9.30p4 or later without 
applying this applications change.

Associated server fix: QCCR1E31941.

QCCR1E7345
2_SM930P4.unl

9.30P4 7.11 - 
9.30

Enables Mandanten restricting queries to be updated 
correctly after a profile is edited.

Associated server fix: QCCR1E71897

QCCR1E6707
2_SM930P4_
SM930.unl

9.30P3 7.11 and 
9.20

Enables users to take advantage of the new 
KMStatusListener background process.

Note: This unload file is not needed for 
applications version 9.30 or later, which supports 
only the Solr Search Engine.

Associated server fix: QCCR1E67071

QCCR1E7016
3_SM930P4_
SM711.unl

9.30P3 7.11 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E7016
3_SM930P4_
SM920.unl

9.30P3 9.20 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E7016
3_SM930P4_
SM930.unl

9.30P3 9.30 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687
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Unload file

Introduc
ed in  
9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E6764
7_SM930P3.unl

9.30P3 7.11 - 
9.30

Updates the exception message that occurs in the 
request response when closing an interaction by 
calling CloseInteraction from a web service without 
specifying the localSolution field in the request.

Associated server fix: QCCR1E54192

QCCR1E6761
0_SM930P2.unl

9.30P2 7.11 - 
9.30

Enables you to block potentially dangerous 
attachments.

Associated server fix: QCCR1E64290

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to load an unload file, because Unload Manager can 
help you create a backup of your old data and reconcile conflicts during the installation of the 
unload; if your application version is other than any of these, Unload Manager is not available 
and you can use Database Manager instead. 

To load an unload file using Unload Manager:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager:
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 1. Make sure the Windows client is configured for server-side load/unload.
 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking 
List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backout 
Instructions" on page 65.

 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this 
field blank.

File Type Select the source operating system of 
the unload file.

Messages Option —  

All Messages Select this option to see all messages 
that Service Manager generates 
loading the file.

Messages Option —  

Totals Only Select this option to see only the total 
number of files Service Manager 
loads.

Messages Option — 
None

Select this option to hide all 
messages that Service Manager 
generates when loading the file.

5 Click Load FG.
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Mobile Application Update Installation

Note: This release does not contain the latest Mobile Application package that has been 
shipped with the SM9.31p1 release. You can download this package from 
http://support.openview.hp.com/selfsolve/document/KM00279017.

For installation instructions, see the Service Manager 9.31p1 Release Notes.

ODBC Driver Update Installation

Note: This release does not contain the ODBC .zip file that has been shipped with the 
SM9.30p4, SM9.30p5, and SM9.31 releases.

You can download the zip file from 
http://support.openview.hp.com/selfsolve/document/KM00207925.

The ODBC Driver update contains the following updated files:

 l Scodbc32.dll

 l sci18n.dll

 l sccl32.dll

To install the ODBC Driver update:

 1. Extract the files to your ODBC Driver installation folder, for example: C:\Program 
Files\Peregrine Systems\ServiceCenter 6.2\ODBC Driver.

 2. When prompted, replace the three old DLL files with the new ones.

Knowledge Management Update Installation
The KM package (sm9.31.2004-P2_KM.zip) in this release includes updated files for the Solr 
Search Engine and the KM Import Utility.

KM Search Engine Update Installation
The KM Search Engine update contains the following files:
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Folder Files

kmsolr_unloads  l QCCR1E67750_SM930P4_SM930.unl

 l QCCR1E75104_SM930P5_SM930.unl

 l QCCR1E77409_SM930P5_SM930.unl

knowledgemanagement  l installasservice.cmd and startup.cmd (updated for JDK7 
support added in 9.31p2)

 l kmsearchengine subfolder (which contains several search engine 
fixes)

The Solr Search Engine update aims to enable the following features or fixes for Knowledge 
Management searches:

 l Support of Knowledge Management search for Service Request Catalog (SRC) 1.4. For more 
information, see the SM9.31 Release Notes.

 l Ability to specify search result sort preferences in Knowledge Management (by Modified Date, 
Status, or Relevancy). For more information, see the SM9.30p4 Release Notes.

 l Ability to select whether or not to highlight attachment content in KM search results. A new 
option (Highlight content of attachment in search result?) is available in the KM 
environment record. By default, this option is not selected, and therefore attachment content in 
user’s KM search results will not be highlighted. This can significantly improve search 
performance when there are a large number of large-size attachments like PDF manuals in the 
knowledgebases. For more information, see the Highlighting Attachment Content in Search 
Results Optional section in the 9.30p5 Release Notes.

 l Fix QCCR75104 (Searches that use "NOT" or '-' to exclude terms produce unexpected results. 
For example, the search results when using the None of these words option in Advanced 
Search may include the search terms that should have been excluded. For more information, 
see the 9.30p5 Release Notes.

 l JDK 7 support ("QCCR1E90386" on page 58): To use JDK7 on a Windows platform, you need 
to update your installasservice.cmd and startup.cmd files with those shipped with the 
9.31p2 KM patch; for UNIX platforms, no file changes are needed to use JDK7.

To install the KM Search Engine update:

Note: JDK 7 Update 17 and Tomcat 6.0.36 have been certified on this release of the 
KM Search Engine. Upgrading to JDK 7 or Tomcat 6.0.36 is optional but recommended.
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 1. Optionally, update your JDK to JDK7 Update 17 if you have not already done so.

 2. (Windows platforms only) If you do not plan to update your JDK, make a backup of your  
installasservice.cmd and startup.cmd files in your KM search engine installation folder.

 3. Optionally, update the KM embedded Tomcat to version 6.0.36.
 a. Make a backup of your existing KM embedded Tomcat folder. 

 b. Download the Tomcat 6.0.36 zip file specific for your operating system.

Caution: The KM search engine requires a 32-bit  Tomcat if running on a 32-bit 
operating system, and a 64-bit Tomcat on a 64-bit operating system.

 c. Extract the zip file to overwrite your existing Tomcat folder. 

Caution: Before this step, be sure not to remove the embedded Tomcat folder, which 
contains certain files that do not exist in the Tomcat 6.0.36 zip file that you 
downloaded. This way these files will remain after you overwrite the old Tomcat folder.

 d. Copy your old Tomcat configuration file (server.xml in the conf folder) back to the 
updated Tomcat folder.

 4. Follow the same steps as described in the KM Solr Search Engine Update Installation 
section in the SM9.31 Release Notes, except that you need to load QCCR1E67750_SM930P4_
SM930.unl instead of QCCR1E67750_SM930P5_SM930.unl.

 5. If you do not plan to update your JDK, copy your old  installasservice.cmd and 
startup.cmd files back.

 6. Restart your KM search engine.

KM Import Utility Installation

Note: The km-import-9.31.zip file included in this release in same with the one shipped with 
previous releases (SM9.30p4, SM9.30p5, SM9.31, and SM9.31p1).

Extract km-import-9.31.zip in the Knowledge Management package to a local drive. For detailed 
instructions on the use of the import utility, see the README file packaged in this .zip file.

HP Service Manager (9.31) Page 82 of 83

Patch 2 Release Notes
Installation Notes



Service Manager Verified Environments
The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software 
products, and other compatibility and support information.

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go to      
Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Compatibility Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

http://support.openview.hp.com/sc/support_matrices.jsp

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.
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